This training manual is focused on providing information and hands-on examples for new SharePoint site owners at Fermilab.
Contents

Useful Online Resources ......................................................................................... 3

References .................................................................................................................. 4

1. What is SharePoint 2010? ................................................................................... 5
2. Log in to the Fermilab SharePoint site ................................................................. 5
3. Getting to know your Fermilab team site ............................................................. 7
   3.1 Viewing your team site in the browser ......................................................... 7
   3.2 Contributing to a team site ........................................................................... 8
   3.3 Using the search box ...................................................................................13
   4.1 Document Libraries ..................................................................................14
   4.2 Create a Document Library .......................................................................14
   4.3 Upload a file to a Document Library .........................................................16
   4.4 Work with documents ..............................................................................16
   4.5 Send a link to a document by e-mail ..........................................................19
   4.6 Recover deleted documents .......................................................................19
   4.7 Create alerts ..............................................................................................20
5. Working with Lists ............................................................................................21
   5.1 Comparison of SharePoint’s List types .......................................................22
   5.2 Create a new List ......................................................................................23
   5.3 Import a spreadsheet to create a List .........................................................24
   5.4 Use the Ribbon to manage Lists ................................................................25
   5.5 Create a column ........................................................................................26
   5.6 Create a List View ....................................................................................26
   5.7 Delete a List ...............................................................................................28
6. Working with web pages ....................................................................................29
   6.1 Creating a new Wiki page ............................................................................29
   6.2 Finding and linking other Wiki Pages .........................................................31
   6.3 Creating a new web part page .....................................................................32
   6.4 Insert a web part ........................................................................................33
   6.5 Configure a web part ..................................................................................34
   6.6 Remove a web part from a page .................................................................35
7. Managing Security ........................................................................................................................................... 36
   7.1 Permission levels...................................................................................................................................... 36
   7.2 Security groups ....................................................................................................................................... 36
   7.3 Creating groups ....................................................................................................................................... 37
   7.4 Add people to groups .............................................................................................................................. 38
   7.5 Breaking inheritance ............................................................................................................................... 39
   7.6 Grant access to a Library ......................................................................................................................... 40
8. Creating new sub-sites ................................................................................................................................... 41
   8.1 Understanding site hierarchy .................................................................................................................. 41
   8.2 Site templates ......................................................................................................................................... 42
   8.3 Create a sub-site ...................................................................................................................................... 44
   8.4 Change the name, description, or URL of a site ..................................................................................... 45
   8.5 Managing navigation ............................................................................................................................... 47
Useful Online Resources

Fermilab Resources:

- Fermilab SharePoint Help Site: https://sharepoint.fnal.gov/help/Pages/HelpHome.aspx

YouTube Videos:

- SharePoint in Plain English: http://www.youtube.com/watch?v=s12Jb5Z2xaE&feature=related

Online resources from Microsoft:

- Microsoft SharePoint 2010 Quick Reference Cards: http://download.microsoft.com/download/d/4/2/d4290c8a-5563-44a7-96a6-9fe77eff40b0/qrc_all.pdf
References

2. SharePoint 2010 How-To, by Ishai Sagi.

This training manual is also built upon the “SharePoint 2010 End User Information” quick guide developed by Alicia Simmons.
1. What is SharePoint 2010?

SharePoint is an extensible and scalable web-based platform that supports the collaboration and sharing of information within teams and throughout the organization.

SharePoint 2010 is the fourth version of SharePoint from Microsoft.

One common use of SharePoint is to create sites that are used for team collaboration. These collaborative sites, also known as team sites, enable team members to better work with one another. They can use the site to share documents, assign tasks, track team events on a shared web calendar and much more.

2. Log in to the Fermilab SharePoint site

The URL is: https://sharepoint.fnal.gov/

1) Click “Sign In”.

![Sign In to SharePoint](image)
2) Enter your Services Account username and password.
3. Getting to know your Fermilab team site

One of the fundamental kinds of web sites that SharePoint 2010 allows you to create is a team site. A team site is a SharePoint site that you can use to collaborate with your coworkers. Other types of SharePoint 2010 web sites are covered in Section 7.

Note: Each organization at Fermilab will be given a testing SharePoint site collection. Your SharePoint trainer will provide the URL to you during your training session.

3.1 Viewing your team site in the browser

First you need to navigate to your team site. All SharePoint team sites have the same features:

a. **Header**: The header spans the entire top of the page.

b. **Left navigation menu**: The navigation pane provides quick access to the site’s document libraries, Lists and discussion boards. You can even add links to content you create, such as documents and web pages.

c. **Page content**: The content displays in the body of the page.
3.2 Contributing to a team site

3.2.1 Modifying the home page

1) Browse to the home page of your team site and then click “Site Actions -> Edit Page”.

The page appears in Edit mode.
2) With the page in Edit mode, you can place your cursor anywhere inside the rectangular boxes in the page’s body to edit the content.

Examples:

To change the title or to add text to the home page, simply click on the page while in edit mode and your input will appear wherever your cursor is.
To Change the Page Layout, click “Text Layout” on the Ribbon.

Note: You can easily navigate to upper-level sites by clicking the “Navigate Up” button.
3.2.2 Uploading documents

SharePoint 2010 uses a special kind of container – a Document Library – for storing files. Your team site has a common default Document Library called “Shared Documents” where you can put documents you want to share with others. Find out more about Document Libraries in Section 4.

1) Click “Shared Documents” in the left navigation menu.


3) Click “Browse” and select a file to upload.

4) Click “Ok”.

5) Fill out the “Name” and “Title” field respectively.

6) Click “Save”. 
3.2.3 Adding calendar items

SharePoint 2010’s team sites provide you with a default calendar for tracking your team events. This calendar can be connected to and viewed in Outlook.

1) Click “Calendar” in the left navigation pane.

2) Click the “Events” tab and then click “New Event”.

3) Type the information for your event.

4) Click “Save”.
3.3 Using the search box

All pages in SharePoint include a search box by default. The search box has a search scope drop-down list.

If you receive far more search results than you were expecting, you can use refiners to drill down into the results to find exactly what you are looking for.

1) Select the search scope you want to use from the drop-down list.

2) Type your search term and click the magnifying glass icon.

3) Click the refiner you want to use, e.g. Webpage.

4.1 Document Libraries
A Document Library is a special kind of List. Find out more about List in Section 5. Document Libraries allow you to manage files such as documents, spreadsheets, and presentations.

A SharePoint site can contain many Document Libraries, and each Document Library can contain a hierarchy of folders and files.

Keep in mind that it is generally not recommended to have too many layers of folders and sub-folders within a Document Library. For ease of navigation, create multiple Document Libraries instead.

Note: Each team site comes with a default Document Library named “Shared Documents”. You can create your own Document Libraries as you like.

4.2 Create a Document Library
1) Click “More Options…” on the “Site Actions” menu.
2) Choose “Library” from the “Filter By:” menu.

3) Select “Document Library”.

4) Enter a name for the Document Library and then click “Create”.

---

Fermilab SharePoint Training
4.3 Upload a file to a Document Library

1) Select the “Documents” tab under “Library Tools” on the Ribbon.

2) Click “Upload Document”.

3) Click “Browse” and in the “Choose File” dialog box, select a file to upload.

4) Click “OK”.

4.4 Work with documents

SharePoint 2010 provides two methods for working with documents:

- Each document has an “Edit” menu that you can use to take some action on that document, such as checking it out for editing.
- The Ribbon also displays a set of actions that can be taken on individual documents or a group of selected documents.
4.4.1 Use the Edit menu

You see the Edit menu when you hover your mouse over the “Name” property of your document. With the “Edit” menu, you can view and edit properties.

4.4.2 Edit a document’s properties

The easiest way to edit a document’s properties is to use the Ribbon:

1) Select the document in the Document Library.
2) Click “Edit Properties” on the “Documents” tab of the Ribbon.
3) Make the changes and click “Save”.
4.4.3 Check documents in and out

Checking out a file prevents other users from editing the file while you are working on it. New edits you make do not show until you check the file back in.

To check out a document:

1) In your Document Library, select the check box next to the document you want to check out.
2) Click “Check Out” on the “Documents” tab of the Ribbon.
3) Click “OK”.

To check in a document:

1) Click the check box next to the document that you want to check in.
2) Click “Check In” on the “Documents” tab of the Ribbon.
3) In the Check In dialog box, do any of the following:
   • Select “Yes” or “No” to keep the file checked out or not.
   • Enter any comments to include in the document’s revision history.
4) Click “OK”.

4.5  Send a link to a document by e-mail

To share your documents with others, they must know where to find the document. One way to do so is to send them a link directly to the document itself.

1) In your Document Library, select the check box next to the document you want to email.
2) Click “E-mail a Link” on the “Documents” tab of the Ribbon.

You default e-mail application will open a new message with a link to the document. You can choose who to send the link to and send the message as you would any other e-mail.

4.6  Recover deleted documents

When you delete a document from a Document Library, it isn’t gone forever. The document just moves to a holding place in your site – the Recycle Bin.

To restore a document from the Recycle Bin to its original location:

1) Click the Recycle Bin link in the left navigation pane.
2) Place a check mark next to any files you wish to restore.
3) Click the “Restore Selection” link.

Note: Items that were deleted more than “30 day(s) ago will be automatically emptied.
4.7 Create alerts

Alerts are a great way to keep track of the changes your teammates make to documents.

To create an alert to a Document Library:

1) Select the Document Library where you want to create an alert.
2) Select the “Library” tab on the Ribbon.
3) Click “Alert Me > Set alert on this library”.
4) Fill out the form and click “OK”.
5. Working with Lists

SharePoint 2010 provides many kinds of Lists that you can use to track information. A List is similar to an Excel spreadsheet or a table in a database.

In a List, data is gathered in rows, and each row is known as a List Item. A List can have multiple columns. A List Item is a row with data in those columns.

For example, a List of Fermilab contacts may have the following columns:

- First Name
- Last name
- Fermilab ID
- Organization
- Email
- Phone

SharePoint provides three basic kinds of Lists:

- **Communication Lists** are used to track announcements, contacts, and discussion boards.
- **Tracking Lists** are used to track information such as links, calendars, tasks, issues, and surveys.
- **Custom Lists** provide a starting template that you can build on to create a List with the exact columns you need.
## 5.1 Comparison of SharePoint’s List types

<table>
<thead>
<tr>
<th>Types of List</th>
<th>When to use it</th>
<th>What makes it special</th>
</tr>
</thead>
<tbody>
<tr>
<td>Announcements</td>
<td>To display brief announcements on your site’s home page</td>
<td>You can enter expiration dates for announcements</td>
</tr>
<tr>
<td>Contacts</td>
<td>To track contacts, especially if you want to use Outlook for data entry</td>
<td>You can remove columns that you don’t need</td>
</tr>
<tr>
<td>Discussion boards</td>
<td>To create a discussion forum where people can post messages and reply to them</td>
<td></td>
</tr>
<tr>
<td>Links</td>
<td>To track hyperlinks</td>
<td>Uses a hyperlink column that automatically formats entered text as HTML anchor links</td>
</tr>
<tr>
<td>Calendar</td>
<td>To track calendar items</td>
<td>Can synchronize with Outlook and knows how to handle recurring events</td>
</tr>
<tr>
<td>Tasks</td>
<td>To track tasks</td>
<td>Can synchronize with Outlook; Task Lists can be grouped with summary tasks</td>
</tr>
<tr>
<td>Project tasks</td>
<td>To track work items for a project.</td>
<td>Can display as a Gantt chart</td>
</tr>
<tr>
<td>Issue Tracking</td>
<td>To track trouble tickets.</td>
<td>Works well with issues that have three states – open, closed, and resolved</td>
</tr>
<tr>
<td>Survey</td>
<td>To take a poll</td>
<td>Allows you to create a set of questions that users must walk through</td>
</tr>
<tr>
<td>Custom</td>
<td>To create a List with columns that you define.</td>
<td>Allows you to create a List specific to your content and can for example act on certain content in special ways</td>
</tr>
<tr>
<td>KPI (Key Performance Indicator)</td>
<td>To display graphical status indicators.</td>
<td>Allows you to evaluate selected business data against specified goals and display that information in various formats such as scorecards and dashboards</td>
</tr>
<tr>
<td>Import Spreadsheet</td>
<td>To create a List based on an existing spreadsheet.</td>
<td>Allows you use an existing Excel spreadsheet as the basis of the List; can help avoid rework and repeated effort entering data</td>
</tr>
<tr>
<td>External</td>
<td>To create a List based on a data source outside SharePoint.</td>
<td>Allows you display data from other non-SharePoint databases or Web services</td>
</tr>
</tbody>
</table>
5.2 Create a new List

1) In your SharePoint site, choose “Site Actions -> More Options…”

2) On the Create page, click the “List” link in the “Filter By” section.

3) Click the icon for the kind of List you want to create.

4) Type a name for your List in the text box that appears.

5) Click the “Create” button.
5.3 **Import a spreadsheet to create a List**

1) Click the “Site Actions” menu and select “More Options…”

2) On the Create page, click the “List” link in the “Filter By” section.
3) Click the “Import Spreadsheet” icon, and then click “Create”.

4) Fill out the Name and Description field. Then click “Browse” in the “Import from Spreadsheet” section.

5) Select the spreadsheet to import, then click “Open”.

6) Click “Import”.

5.4 Use the Ribbon to manage Lists

All SharePoint Lists display the Ribbon at the top of the List. You can use the Ribbon to access the common tasks used for working with Lists.

The menu commands you see in the Ribbon depend on the kind of List you are viewing. Usually the Ribbon displays List commands in one of two tabs:

- **Items**: displays all the commands you need for working with items.

- **List**: displays commands for managing and customizing the entire List, such as creating views and exporting the List to Excel.
5.5 Create a column
1) Select the List you want to work with.
2) Click the “List” tab on the Ribbon.
3) Click “Create Column”.
4) Enter a name for the column.
5) Select the type of information you want to store in the column.
6) Click “OK”.

5.6 Create a List View

Views provide a flexible way to create custom display forms for users interacting with list data. Views provide the ability for you to control which fields are displayed; the order in which fields appear in the list; and advanced multicolumn sorts and multicolumn filtering.

To create a List view:
1) Select the List in which you are interested.
2) Click “Create View” on the “List” tab.
3) Click “Standard View”.

4) Enter a view name. The name must be unique to the list.

5) In the “Audience” section, select one of the available options:
   - “Create A Personal View” creates a view that is only displayed for you.
   - “Create A Public View” creates a view that other users can select and use.

6) In the “Columns” section, do any of the following:
   - Click the check box under the Display column to show or hide a column in the view.
   - Change the order in which columns are displayed in the view by selecting a position value from the drop-down list under “Position From Left”.

7) Click “OK” to save the view.
5.7 Delete a List

1) Select the List you want to delete.

2) Click “List Settings” on the “List” tab.

3) Click “Delete This List”.

4) Click “OK”.

List Information

| Name:    | Tasklist |
| Web Address: | https://sharepoint.final.gpo/col/site/Lists/Tasklist/AllItems.aspx |
| Description: | Use the Tasklist to keep track of work that you or your team needs to complete. |

General Settings

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Versioning settings</td>
<td></td>
</tr>
<tr>
<td>Advanced settings</td>
<td></td>
</tr>
<tr>
<td>Validation settings</td>
<td></td>
</tr>
<tr>
<td>Rating settings</td>
<td></td>
</tr>
<tr>
<td>Audience targeting settings</td>
<td></td>
</tr>
<tr>
<td>Metadata navigation settings</td>
<td></td>
</tr>
<tr>
<td>Per-location view settings</td>
<td></td>
</tr>
<tr>
<td>Form settings</td>
<td></td>
</tr>
</tbody>
</table>

Permissions and Management

<p>| |</p>
<table>
<thead>
<tr>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete this list</td>
</tr>
<tr>
<td>Save list as template</td>
</tr>
<tr>
<td>Permissions for this list</td>
</tr>
<tr>
<td>WorkFlow Settings</td>
</tr>
<tr>
<td>Enterprise Metadata and Keywords Settings</td>
</tr>
<tr>
<td>Generate site plan report</td>
</tr>
<tr>
<td>Information management policy settings</td>
</tr>
<tr>
<td>Record declaration settings</td>
</tr>
</tbody>
</table>

Communications

<p>| |</p>
<table>
<thead>
<tr>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>RSS settings</td>
</tr>
</tbody>
</table>
6. Working with web pages

Your team site is a collection of web pages. There are two different types of web pages for displaying your content:

- **Wiki pages**: Wikis derive their name from the Hawaiian word for “quick”. The Wiki concept is designed to be quick and easy. Use Wiki pages when you have predominantly Rich content; for example, text, tables, links, and images. You can still insert Web Parts, or use no Web Parts at all.

- **Web Part pages**: Use when you need mostly Web Parts with little text content. Web parts are the building blocks of pages in SharePoint. They are components that show data, and they can be placed in certain regions of a page – known as “web part zones”. A page can hold many web parts, in different zones or in the same zone. SharePoint comes with a wide range of out-of-the-box web parts.

6.1 Creating a new Wiki page

1) Click “Site Actions -> New Page”.

2) Type the name for your page and click the “Create” button.
Note: You can change the page’s layout by clicking “Text Layout” on the “Format Text” tab.
6.2 Finding and linking other Wiki Pages

1) Go into the Edit mode in a Wiki page by clicking the Edit button.

2) Click “View All Pages” under the Page tab to see other pages in the same Wiki page library.

3) You can link to another page in the same wiki library by enclosing the name of the page in double brackets in the rich content area. For example, type [[Team Events Page]] to create a link to the Team Events page.
6.3 Creating a new web part page

1) Click the “Site Actions” menu and select “More Options…”

![Site Actions menu]

2) Click the “Web Part Page” link under the “Page” category.

![Web Part Page link]

3) Type a name for your page in the Name field.

4) Select a layout for the page by choosing an option from the List.

5) Select the Document Library that will contain this page by selecting an option from the Document Library drop-down List.

6) Click the “Create” button.
6.4 Insert a web part

1) Click “Site Actions -> Edit Page”.

2) In a web part page, click in a zone. In a Wiki content page, click in a rich content zone.

3) To insert a web part, click the web part button on the Insert tab.

4) Select the web part name and click “Add”.

6.5 Configure a web part

1) Click “Site Actions -> Edit Page”.

2) Select the drop down control to the right of the Web Part title and click “Edit Web Part”.

3) Modify the configurations as you like.
6.6 Remove a web part from a page

1) Click “Site Actions -> Edit Page”.

2) Select the drop down control to the right of the Web Part title and click “Delete”.

7. Managing Security

7.1 Permission levels
When a team site is set up, SharePoint creates nine permission levels:

- **Full Control**: Allows total control of a site. User can add, delete, approve, move and create new sites.
- **Design**: User can view, add, delete, update, approve, and customize a SharePoint site.
- **Manage Hierarchy**: User can create sites and edit pages, List items, and documents.
- **Approve**: User can edit and approve pages, List items, and documents.
- **Contribute**: User can view, add, update, and delete List items and documents.
- **Read**: User can view pages and List items and download documents.
- **Restricted Read**: User can view pages and documents, but cannot view historical versions or user permissions.
- **Limited Access**: Users at this level can view specific Lists and document libraries when given access.
- **View Only**: Similar to the Read permission level, but users at this level cannot download items.

7.2 Security groups
When a site is created, SharePoint automatically provides three security groups:

- **Site Members**: Given “Contribute” permission.
- **Site Owners**: Given “Full Control” permission.
- **Site Visitors**: Given “Read” permission.

Note: Additional groups may be created. Remember that groups are only containers of users; groups need to be given a permission level to be of any use.
7.3 Creating groups

1) Click “Site Permissions” on the “Site Actions” menu.

2) Click “Create Groups” on the “Permission Tools” Edit tab.

3) Enter a name for the group.

4) Enter a description for the group.

5) Choose a permission level for the group.

6) Click “OK”.

7.4 Add people to groups

1) Click “Site Permissions” on the “Site Actions” menu.

2) Click “Grant Permissions” on the “Permission Tools” Edit tab.

3) Under Select Users, type the person’s name in the Users/Groups box and then press “Enter”.

4) Under “Grant Permissions”, use the drop-down List to select the group that you want to add the person to.

5) Click “OK”.

7.5  Breaking inheritance

By default, child objects (Sites, Lists, and Libraries) inherit their permissions from their parent object. For example, a Library inherits the permissions of the Site it is created in, and a document inherits the permissions of the Library it is uploaded to. If an object inherits permissions, you need to stop inheritance before you can change the object’s permissions.

1) Select the List or Library you want to work with.
2) Under “Library Tools” on the Ribbon, select the “Library” tab.
3) Click “Library Permissions”.
4) Click “Stop Inheriting Permissions”.

![Stop Inheriting Permissions](image)
7.6 Grant access to a Library

1) Select the library you want to work with.

2) Under “Library Tools” on the Ribbon, select the “Library” tab.

3) Click “Library Permissions”.

4) Click “Grant Permissions”.

5) Type the person’s name in the Users/Group box.

6) Specify whether to add the user to a group or to grant permissions directly.

7) Click “OK”.
8. Creating new sub-sites

8.1 Understanding site hierarchy

The structure of SharePoint sites is very different from the structure of typical Internet sites that contain only pages. In SharePoint, a site can house more than just pages. It is a container that holds Lists and Libraries, and it can have other sites under it.

Every SharePoint site is a member of a site collection. As the name implies, a site collection is a collection of sites. Every site collection has a single site as its root site. Other sites, called sub-sites, can be built under the root site. A site collection has some attributes that are common to all the sites in that collection, such as shared permissions, galleries for templates and content types.

Note: At Fermilab, only SharePoint administrator has the permission to create site collections.
### 8.2 Site templates

SharePoint 2010 comes with many site templates that are ready to be used out of the box.

<table>
<thead>
<tr>
<th>Template Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assets Web Database</td>
<td>An assets database to keep track of assets, including asset details and owners.</td>
</tr>
<tr>
<td>Basic Meeting Workspace</td>
<td>A site that you can use to plan, organize, and capture the results of a meeting. It provides Lists for managing the meeting’s agenda, meeting attendees, and documents.</td>
</tr>
<tr>
<td>Basic Search Center</td>
<td>A site that provides search functionality. The site includes pages for search results and advanced searches.</td>
</tr>
<tr>
<td>Blank Meeting Workspace</td>
<td>A blank meeting site that you can customize to meet your requirements.</td>
</tr>
<tr>
<td>Charitable Contribution Web Database</td>
<td>A database to track information about fundraising campaigns, including donations, campaign-related events, and pending tasks.</td>
</tr>
<tr>
<td>Contacts Web Database</td>
<td>A contacts database to manage information about people that your team works with, such as customers and partners.</td>
</tr>
<tr>
<td>Decision Meeting Workspace</td>
<td>A site you can use to track the status of issues or make decisions at meetings. It provides Lists to create tasks, store documents, and record decisions.</td>
</tr>
<tr>
<td>Document Center</td>
<td>A site that can be used to centrally manage documents in your organization.</td>
</tr>
<tr>
<td>Document Workspace</td>
<td>A site on which colleagues can work together on a document. It provides a Document Library for storing the primary document and supporting files, a tasks List for assigning to-do items, and a links List to point to resources that are related to the document.</td>
</tr>
<tr>
<td>Enterprise Search Center</td>
<td>A site that provides search functionality. The Welcome page includes a search box that has two tabs, one for general searches and another for searches for information about people. You can add and customize tabs to focus on other search scopes or result types.</td>
</tr>
<tr>
<td>Enterprise Wiki</td>
<td>A site that can be used to publish knowledge that you capture and want to share across an enterprise. It provides an easy content-editing experience in a single location for coauthoring content, for discussions, and for managing projects.</td>
</tr>
<tr>
<td>Group Work Site</td>
<td>This template provides a groupware solution that teams can use to create, organize, and share information. It includes a group calendar, a circulation List, a phone call memo List, a</td>
</tr>
<tr>
<td><strong>Document Library</strong></td>
<td>Document Library, and the other basic Lists.</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td><strong>Issues Web Database</strong></td>
<td>An issue database to manage a set of issues or problems. You can assign, prioritize, and follow the progress of issues from start to finish.</td>
</tr>
<tr>
<td><strong>Microsoft Project Site</strong></td>
<td>A site that supports team collaboration on projects. This site includes project documents, project issues, project risks, and project deliverables Lists that can be linked to tasks in Microsoft Project Server 2010.</td>
</tr>
<tr>
<td><strong>Multipage Meeting Workspace</strong></td>
<td>A site on which you can plan a meeting and capture the meeting’s decisions and other results. It provides Lists for managing the agenda and meeting attendees. It also provides two blank pages that you can customize based on your requirements.</td>
</tr>
<tr>
<td><strong>Projects Web Database</strong></td>
<td>A project tracking database to track multiple projects and assign tasks to different people.</td>
</tr>
<tr>
<td><strong>Publishing Site</strong></td>
<td>A blank site for expanding your Web site and quickly publishing Web pages. Contributors can work on draft versions of pages and publish them to make them visible to readers. This site includes document and image libraries for storing Web publishing assets.</td>
</tr>
<tr>
<td><strong>Publishing Site with Workflow</strong></td>
<td>A site for publishing Web pages on a schedule by using approval workflows. It includes document and image libraries for storing Web publishing assets. By default, only sites based on this template can be created under this site. This template is available only at the site level when the Publishing Portal template is used to create the top-level site.</td>
</tr>
<tr>
<td><strong>Records Center</strong></td>
<td>A site that is designed for records management. Records managers can configure the routing table to direct incoming files to specific locations. The site also enables you to manage whether records can be deleted or modified after they are added to the repository.</td>
</tr>
<tr>
<td><strong>Social Meeting Workspace</strong></td>
<td>A site on which you can plan social occasions. It provides Lists for tracking attendees, providing directions, and storing pictures of the event.</td>
</tr>
<tr>
<td><strong>Team Site</strong></td>
<td>A site on which a team can organize, author, and share information. It provides a Document Library and Lists for managing announcements, calendar items, tasks, and discussions.</td>
</tr>
<tr>
<td><strong>Visio Process Repository</strong></td>
<td>A site on which teams can view, share, and store Microsoft Visio process diagrams. It provides a versioned Document Library for storing process diagrams and Lists for managing announcements, tasks, and review discussions.</td>
</tr>
</tbody>
</table>
8.3  Create a sub-site

1) Click “New Site” on the “Site Actions” menu.

2) Under All Categories, select a site template, e.g. blog site.
3) Enter a title for the site.

4) Enter a URL for the site.

5) Click “Create”.

8.4 Change the name, description, or URL of a site

1) Click “Site Settings” on the “Site Action” menu.
2) Click “Title, Description, And Icon” in the “Look And Feel” group.

3) Change the title.
4) Change the description.
5) Click “OK”.
8.5 Managing navigation

Within each site and site collection, you have the ability to control the navigation. Navigation includes two regions on the page:

- The top navigation menu: Global navigation area
- The left navigation menu: Current navigation area
8.5.1  Modify the left navigation bar

1) Click “Site Settings” on the “Site Action” menu.

2) Click “Navigation” in the “Look And Feel” group.
3) In the “Sorting” section, select the “Sort manually” option.

![Sorting section]

4) In the navigation Editing and Sorting section, select the Current Navigation folder then click “Add Heading…” or “Add Link…”

![Navigation Editing and Sorting]

5) Add the pertinent information.

6) Click “OK”.

7) Click the new heading or link to select it. Then click “Move Up” or “Move Down” until the menu item is listed in the order you desire.

8) Click “OK”.

---

Fermilab SharePoint Training
8.5.2 Modify the top navigation bar

1) Click “Site Settings” on the “Site Action” menu.

2) Click “Navigation” in the “Look And Feel” group.
3) In the Global Navigation section, select the option to show sub-sites.

4) In the navigation Editing and Sorting section, select the Global Navigation folder.

5) If you want, you can add a heading or link or hide a site.